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1.0 Introduction 

The Large Area Scanner (LAS) system has been designed and built by Pacific Northwest National 
Laboratory (PNNL).  This document is one portion of the documentation set provided for the LAS 
system.  It provides step-by-step user guidance for performing routine LAS operations.  It is not intended 
to provide complete safety of operation guidelines for LAS operations.  

It is essential that the operator and all users read and understand the LAS Operations & 
Maintenance Manual

 

 provided in the system documentation. 
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2.0 Setup Procedures 

2.1 Site Setup 

2.1.1 Scanner Location 

A number of issues related to location and orientation of the LAS scanner are: 

1. The pavement surface should be level and firm. 

2. The object area in front of the scanner should also be firm and level. 

3. As a rule of thumb, the object space should be twice the size of the object in all dimensions.   

2.1.2 Data Acquisition Workstation (Computer) 
1. The Data Acquisition Workstation should be located off to the rear side of the LAS scanner. 

2. Connect the Ethernet cable from the LAS interconnect panel to the Workstation. 

2.1.3 Object location 
1. Clutter considerations:  Try to configure the range for minimum range clutter.  

2. Down range position:  The leading edge of the object should be at least twice the separation distance 
of the dual antennas.  

2.2 Daily Initialization & Shutdown 

2.2.1 Initialization 

2.2.1.1 Daily Basic System Assembly 
1. Place an E-stop at the Data Acquisition Workstation computer and at the scanner shuttle location. 

2. Turn on main power to system using the 110V and 220V breakers inside connector enclosure located 
on rear side of scanner trailer. 

3. Install transceiver if not already in place on the scanner shuttle.  Make all power and control 
connections to transceiver and confirm proper operation using handheld controller. 

4. If necessary, refer to Section 6.4 of the LAS Operations and Maintenance Manual for detailed 
instructions on system setup. 

2.2.1.2 Daily Software Setup on Data Acquisition Workstation Computer 
1. Power on the Data Acquisition Workstation computer. 

2. Open AhisWin Studio using the shortcut icon located on the Windows desktop screen.  The software 
may also be invoked from the Windows Start menu using the Start > All Programs > AhisWin Studio 
entry. 
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3. Confirm connection with the motor controller by open a command shell window using Start -> Run -
> cmd.  At the command prompt, enter “ping 192.168.1.30” without the quotation marks.  This 
command sends test data packets to the IP address used by the motor controller.  Verify that the 
response message states that all packets were received and not lost. 

4. Confirm connection with the sensor control module by opening a web browser such as Internet 
Explorer and entering “192.168.1.125” without the quotation marks into the address bar.  Press the 
button labeled “Waveform Test and Review” to collect a stationary waveform.  View the waveform 
that is collected and verify that it is reasonable. 

2.2.2 Shutdown 

2.2.2.1 Daily Basic LAS System Disassembly 
1. Remove Transceiver 

a. Put protective caps on all connectors 

b. Store sub-system in instrument trailer 

2. Move boom to stow position 

3. Turn off main power (behind rack) 

2.2.2.2 Daily Software Shutdown of the LAS Computer Console 
1. Exit AhisWin Studio and all AhisWin applications 

2. Select Windows START menu.  Select Shutdown 

3. Perform this procedure on all active computers 
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3.0 Pre-Scan Stationary Calibration Procedure 

NOTE:  System should be in the initial setup state described in Section 2.2.1. 

3.1 Creating the Calibration Frame and Determining Waveform 
Parameter Selection 

1. Create a Calibration Frame in the target AhisWin Studio Project.  If a new Project is needed see 
Appendix A1.1.  Adding a new Frame to a Project is explained in Appendix A1.2. 

2. It is required that all raw-data files (.apr) within a Frame have exactly the same waveform 
characteristics.  These include: number of polarization channels, Complex or Real data, Start 
Frequency, Bandwidth, Number of Frequency Samples and Frequency Increment.  It is up to the 
operator to determine the Start Frequency, Bandwidth, and Frequency Increment. 

3. Typically the center frequency is determined by the object and scope of the test measurements. 

4. The Bandwidth chosen determines the down-range image resolution.  Typically, one would like the 
down-range resolution to be approximately the same as the lateral resolution. 

5. Down range resolution is given by dZ = C/2B where C is the speed of light (3E8m/s) and B is the 
bandwidth.  From this, a 6 GHz bandwidth should give a resolution of 2.5 cm which is the same 
downrange resolution as lateral resolution. 

6. The number of samples is determined by the maximum range of any reflector in the scene and is 
given by Nf  >  2BR/C where B is the bandwidth, R as the farthest downrange reflector distance in 
the scene, and C is the speed of light.  For example: with a 6GHz bandwidth and an Nf of 1024, the 
maximum distance a scene object signal can be received without aliasing is 25.6-meters.  In order to 
reduce clutter in the measurements, this value must be chosen properly.  

7. Test the Waveform Sampling and Bandwidth selected. 

– Right-click on any .apr file in the Frame. 

– Select ‘Duplicate this File (Template Only)…’ 

– Rename this file to test.apr 

– Right click on test.apr 

– Select ‘Capture/Scan new data…’.  This will start the Data Acquisition and Scanner Control 
Application. 
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Figure 3.1.  Hardware Settings Dialog Box 
 

The first time the ‘Data Acquisition and Scanner Control’ application runs after 
a software installation or upgrade, the Hardware Settings dialog box as shown in 
Figure 3.1 will be displayed.  If this dialog does not appear, then invoke it by 
selecting ‘CURRENT HARDWARE SETTINGS’ in the ‘Hardware’ pull down 
menu.  The following settings should be selected: 

• Scanner Device: ‘NIST LAS - Large Area Scanner’ 
• Beginning Scanner Location (Home): ‘Center of XY Scan’ 
• Configure Communications Ports (Scanner:  Network 192.168.1.30) 
• Data Input Device: ‘PNNL Sensor Processor Data Acquisition Module’ 
• ADC Gain: ‘x1  (+-1.0 volts)’ 
• Data Averaging Factor: ‘1’ 

Press the ‘Accept these values’ or ‘Ok’ button. 

– Confirm that the Waveform Properties, and Polarization Properties are properly set in the 
‘Transceiver’ tab.  

– Press the ‘Stationary, Single waveform’ task bar button   to begin data collection.  

– View the waveform result by pressing  to invoke the GraphView visualization application for 
this data. 

– Review the waveform to verify that it is as expected.  Selecting the range domain (FFT) of the 
frequency domain, will reveal if down range aliasing is present. 
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3.2 Baseline Calibration (Open Air) 
1. Scanner 

a. Position boom in the full vertical position. 

b. Position transceiver well above ground (minimum clutter) with no object reflections. 

2. Host Computer 

a. Open the calibration Frame in AhisWin Studio application 

b. Right click on the Air.ahr data file (filename is typical) 

c. Select ‘Capture/Scan new data…’.  This will start the Data Acquisition and Scanner Control 
Application. 

d. Make sure the Waveform Properties, and Polarization Properties are properly set in the 
‘Transceiver’ tab. 

e. Press the ‘Stationary, single waveform’ task bar button   to begin data collection.  

f. After data collection is complete, select No in the dialog window that requests to synchronize File 
Properties with Hardware Settings. 

g. Exit the ‘Data Acquisition and Scanner Control’ application. 

3.2.1 Plate Calibration Fixture Operation 
1. Scanner 

a. Mount the flat plate on the Polarimetric Calibration Fixture shaft. 

b. Position the plate to be normal to the antenna centerline and measure the distance of the plate to 
the phase center of the antennas. 

2. Host Computer 

a. Open calibration Frame in AhisWin Studio application 

b. Right click on the Plate.ahr data file (filename is typical) 

c. Select ‘Capture/Scan new data…’.  This will start the Data Acquisition and Scanner Control 
Application. 

d. Invoke the Hardware Settings Dialog box by selecting ‘CURRENT HARDWARE SETTINGS’ 
in the ‘Hardware’ pull down menu.  See Figure 3.1.  The following settings should be selected: 

• Scanner Device:  ‘NIST LAS -  Large Area Scanner’ 
• Beginning Scanner Location (Home):  ‘Center of XY Scan’ 
• Configure Communications Ports (Scanner:  Network 192.168.1.30) 
• Data Input Device:  ‘PNNL Sensor Processor Data Acquisition Module’ 
• ADC Gain:  ‘x1  (+-1.0 volts)’ 
• Data Averaging Factor: ‘ 1’ 

Press the ‘Ok’ button. 

e. Confirm that the Waveform Properties, and Polarization Properties are properly set in the 
‘Transceiver’ tab. 
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f. Press the ‘Stationary, Single waveform’ task bar button   to begin data collection.  

g. After data collection is complete, select No to the dialog that requests to synchronize File 
Properties with Hardware Settings. 

h. Exit the ‘Data Acquisition and Scanner Control’ application. 
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4.0 Normal Data Collection, Reduction & Analysis 

NOTE:  System should be in the initial setup state described in Section 2.2.1.  Also, all ‘pre-scan’ 
calibration operations should be performed before data is collected on the Object under test (see Sections 
3, 5, and 6). 

4.1 Data Collection 

4.1.1 Object Setup 
1. Place object in central location relative to the scanner position.  For small objects consider suspending 

them above the ground to reduce ground clutter. 

2. If the object is large and is setting on the ground, position the transceiver using the joystick at the 
center lateral position and at the bottom elevation. 

3. If the object is small and is on a pedestal or is suspended, then align the transceiver with the center of 
the object. 

4.1.2 AhisWin Studio Operation (Data Acquisition Workstation) 
1. Start AhisWin Studio on the Data Acquisition Computer in an existing or New Project  

– Open AhisWin Studio into an existing project by… 

○ Selecting the appropriate .apr file on the way in, or 
○ Double-clicking on the appropriate .apr file in MS Explorer, or 
○ Selecting the File pull-down menu and then Open, or 
○ Selecting the File pull-down menu and selecting the desired Project on the Most Recent List. 

– For creation of a New AhisWin Project refer to Appendix A1.1. 

2. Open or create an AhisWin Studio Frame to receive this data. 

– To create a Frame…  In the TreeView (left pane), right click on the Project and create a New 
Frame as described in Appendix A1.2.  Import Template data files and Calibration files.  Select 
the Frame-Type as ‘PLANAR, Single-Channel’ 

– Open (or ‘Set Active’) an existing Frame by… 

○ Double-clicking on its icon in TreeView, or 
○ Right-clicking on its icon to display a pop-up menu and selecting ‘set as Active Frame’. 

– Confirm that the Frame-Type is ‘PLANAR, Single-Channel’.  This can be changed by selecting 
the Pull down menu in the Process FormView Pane (see Figure 4.1). 
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Figure 4.1.  AhisWin Studio Planar Single-Channel Frame 
 
 

3. Start the Scanner Interface Application for this new data set. [ScannerApp] 

– Right click on the data file’s icon.  This is the file that will receive the data. 

– Select ‘Capture/Scan new data…’.  ScannerApp will be started.  See Figure 4.2. 
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Figure 4.2.  ScannerApp Window 
 

4. Confirm that ‘hardware’ settings are correct before initiating a scan. 

– Select ‘Hardware’ pull-down menu.  The settings should be as shown in Figure 3-1 

– Particularly, confirm the ‘Beginning Scanner location (Home)’ is set correctly. 

– To modify these settings, click the left mouse button on any related field. 

5. Confirm the Waveform Properties, and Polarization Properties are properly set in the ‘Transceiver’ 
tab.  Figure 4.3 shows typical Transceiver related values.  These values must match for all .apr files in 
this Frame.  (The single exception to this is that the ‘Object Distance’ field only matters in the Plate 
(phase calibration) file.  It has no meaning in any other file.) 
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Figure 4.3.  Typical Transceiver Parameters 
 

6. Confirm that the Scan Properties are properly set in the ‘Scanner’ tab.  See Figure 4.4 for typical 
values.  Lateral increments are typically 1cm.  Speed and Acceleration in both axes are recommended 
to be as shown in Figure 4.4.  Faster vertical acceleration may cause the Laser Tracker to lose track 
frequently.  Faster scan speed may cause the PRF to exceed data collection capabilities. 
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Figure 4.4.  Typical Scanner Parameters 
 

7. Press the ‘Begin scan’ button  on the tool bar.  This will initiate the scanner/data acquisition 
process. 

– Initially a prompt will appear to over-write the existing file.  Press OK to this prompt. 

– The process will initially pre-allocate the data file if necessary.  This may take quite a while if the 
file is large. 

– A prompt to find the Scanner Home will be displayed.  It is a good idea to always locate Home 
(bottom limit of the vertical axis) prior to each scan sequence. 

– A prompt to manually place the transceiver at the initial position will be displayed. 

– A prompt to begin scanner motion will be displayed. 
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– The data collection phase will begin once the perimeter scan is performed for the Laser Tracker 
Calibration. 

8. Monitor the scan progress of data collection: 

– By pressing the ‘View center plane data file’ toolbar button .  This will display the associated 
.csv file in ImageViewApp and continuously update it as new data is acquired.  The 
ImageViewApp operation is described in Section 4.3.2. 

– By pressing the ‘’View data waveform’ toolbar button .  This will display specific waveforms 
in the .apr raw data file.  Make sure an azimuth (X) value is selected that contains data that has 
been collected.  After plotting the waveform, the mouse scroll button may be used to sequence to 
other waveforms on that scan line.  The GraphViewApp operation is described in Section 4.3.1. 

9. Now is a good time to document the scan.  Update the User Notes entry and import pictures of the 
setup into the Frame that is being generated.  Photos may be imported by drag/drop from Explorer 
into the TreeView with the Frame active.  This applies to still shots from the Sony camera.  Place the 
Memory Stick into the reader and use Explorer to drag/drop the files.  These photos can be easily 
imported into the Frame by drag/drop from Explorer. 

4.2 AhisWin Studio Data Processing 

Note:  It is assumed that a successful data collection sequence has occurred, and that the current 
Frame is active. 

4.2.1 Interactive Data Processing 
1. Activate the Single Channel Frame to be processed in TreeView.  See Figure 4.1.   
 

 
 

Figure 4.5.  Object File and Frame PreProcessing Page 
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Figure 4.6.  PreProcessor Dialog Box 
 

2. Execute Preprocessing. 

– Press the ‘PreProcessor Compute…’ button located on the ‘Object File and Frame PreProcessing’ 
page.  (See Figure 4.5) 

– The dialog box shown in Figure 4.6 is displayed. 

– The user changeable controls are preloaded with the settings from the last time this was run.  If 
these are correct, then press ‘Execute’ to begin the PreProcessor. 

– If these are not correct, then press ‘Set to Default Values’ to load initial settings in these fields. 

– In the Waveform Calibration box, the ‘Reference distance…’ is editable.  Typically, though, this 
is read from the header of the calibration file and should not be changed.  This is the ‘Object 
Distance’ field in the header.  This is the measured distance of the reference plate to the phase 
center of the antennas.  

– The ‘Range Gate…’ fields need to have values that encompass the actual distance of the object 
(as measured from the phase center.  Typically at least a 2-Meter envelope in front of the object 
and behind the object is a good rule to follow.  This gate will be imposed on the unfocussed 
waveforms, so the off-axis object distances need to be included.  This range entered here will be 
the down range extent of the 3D image computed later.  So it is a good idea to provide a margin 
in front and in back so that edge effects will not distort the object’s image.   

– The rest of the fields in the ‘Computational Parameters’ box are typically left in the default state.  

– Press ‘Execute’ to begin execution of this function. 
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Figure 4.7.  Image Processing Page 
 
 

 
 

Figure 4.8.  Image Processing Dialog Box 
 



  

16 

3. Compute Image 

– Select the ‘Image Processing’ page.  (See Figure 4.7) 

– If a calibrated image is desired (See Section 5) then enter the DB value of the reference data.  
Then a reference image filename may be entered and the program will use its maximum value for 
the linear reference value, or enter the image linear value that corresponds to the DB level.  When 
Image Calibration is enabled, the Image Computation software will scale the resulting image in 
DB using the Reference Linear Value as its scale factor.  If the Image Calibration is disabled, the 
resulting image will be stored in relative linear units.   

– Press the ‘Compute Image…’ button on the ‘Image Processing’ page.  

– The dialog box shown in Figure 4.8 is displayed. 

– Press the ‘Set to default values’ button.  This sets the fields to the recommended values. 

– Press the ‘Execute’ to begin processing the image.  
 
 

 
 

Figure 4.9.  Angular Spectrum Page 
 

4. Compute Angular Spectrum 

– Select the ‘Angular Spectrum Processing’ page.  (See Figure 4.9) 

– If a calibrated (DBSM) Angular Spectrum is desired, then a Reference Sphere’s intermediate file 
(.ahi) must be imported into this Frame (see Section 6).  If the target Frame is linearly polarized, 
then select one of the Linear Co-Polarized intermediate sphere files (either HH or VV).  If the 
target Frame is circularly polarized, then use one of the Circular Cross-Polarized intermediate 
sphere files (either RL or LR). 
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– If angular spectrum calibration is not chosen, the results will be in relative linear units.  This may 
be converted to DB after this program’s execution using a subsequent Utility Function (‘Scale 
data to DB…’).  

– Press the ‘Compute Angular Spectrum…’ button to begin execution of this function. 

– The ‘Angular Spectrum Dialog Box’ will appear at this point (Figure 4.10). 

– The applications keep track of the relative gain of data files, so do not adjust the relative gain 
fields.  These should be always 1. 

– Press the ‘Execute’ button to run this function. 
 
 

 
 

Figure 4.10.  Angular Spectrum Dialog Box 
 

4.3 AhisWin Studio Visualization 

The AhisWin Studio visualization package consists primarily of 2 main programs.  GraphViewApp 
will display a 1D plot of any AhisWin binary data file.  Typically this program is used to view waveforms 
and the FFT of the waveforms.  In addition this module can be used to plot amplitude profiles of image 
files. 

ImageViewApp provides a versatile interactive display tool for 2D visualization of all of AhisWin 
Studio binary file types.  These include raw data waveform files, single plane and multi-plane image files, 
angular spectrum files and intermediate data files. 

4.3.1 Using GraphViewApp 

The GraphViewApp tool is provided for visualizing data in a 1D Graph presentation.  LAS raw data 
files are complex data values in end-to-end waveform order.  Figure 4.11 shows a typical raw data 
waveform.  The vertical axis is in volts while the horizontal axis is frequency.   
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Figure 4.11.  Typical GraphViewApp Window 

The left mouse button may be double-clicked anywhere in the graphing window to display the 
Settings Dialog Box.  This allows the user to modify the display characteristics in a variety of ways.  See 
Figure 4.12.  When the ‘Space’ Graph Domain is selected a Fourier Transform of the frequency data is 
presented. 
 

 
 

Figure 4.12.  GraphViewApp 'Settings' Dialog Box 
 



  

19 

 
 

Figure 4.13.  GraphViewApp Time/Space Domain Graph 
 

Various options are available in the Settings Dialog depending on the characteristics of the source 
data.  When viewing 3D file data the user is allowed to select the coordinates of the waveform to be 
plotted and display any of the 3 axes as independent variables.  Select an independent variable and then 
select the specific coordinate of that waveform to be plotted.  

One useful feature is to be able to rapidly sequence adjacent waveforms with the scroll mouse button.  
This is automatically enabled for 3D data sets that have the native Independent Variable selected.  For 
example, a raw data file is ordered one waveform after another (waveform format).  The native (most 
rapidly changing) Independent Variable within this file format is the Frequency axis.  If this is selected, 
then the scroll button is active for rapid sequential viewing.  Click inside the graph window and 
sequentially view waveforms within the adjacent line of data.  

If the data file is real and linear, like an image file, then data may be scaled in dB.  See Figure 4.14 
for an example of this. 

The contents of GraphViewApp may be transferred a variety of ways.  The window as displayed can 
be saved into the clipboard by pressing the Ctrl-C keys while the mouse is in the window.  From this the 
image can be pasted into any application that can receive BMP images, such as Paint, PowerPoint or 
Word. 

Alternatively, the data values may be saved into a .csv file using the SaveAs… feature of the File pull 
down menu.  This file may be imported into MS Excel or opened and read at a later date by 
GraphViewApp. 
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Figure 4.14.  dB Scaled Data from an Image Binary Data File 
 

4.3.2 Viewing Image Files and other Binary Data Files with ImageViewApp 

ImageViewApp is designed to provide a versatile visualization tool for 2D displays.  All AhisWin 
Studio binary formats may be displayed with this tool.  These include raw data waveform files, single 
plane and multi-plane image files, angular spectrum files and intermediate data files. 

ImageViewApp settings can be changed by invoking the Settings Dialog box.  This box is usually 
displayed as the data file is opened.  The user has the opportunity to adjust these settings before the data is 
rendered onto the canvas.  It is always available by selecting ‘Settings…’ in the menu displayed when the 
right mouse button is clicked in the canvas region.  Double left mouse clicks in the margin area of the 
canvas will display the Settings dialog also. 

Figure 4.15 shows the ‘General’ tab features of the Settings dialog.  The graticule overlay and the text 
that surrounds the image region may be shown or hidden by checking the appropriate box.  The Auto-
refresh feature is available primarily to view the .cvf file during data collection.  This file is being 
continuously updated with new data at this time and having the display automatically update provides the 
operator with a powerful real-time diagnostic monitor. 
 



  

21 

 
 

Figure 4.15.  'General' Tab Features in the Settings Dialog 
 

The ‘Left mouse button action’ gives the user a way to further visualize the data. Check ‘Select 
region of interest’ to define a rectangular sub-region to view or act upon.  Left click in one corner of the 
desired box and drag the box across the full area.  Releasing the left mouse button completes the 
definition of this sub-region.  Select the  button on the toolbar to zoom into this region.  Press it again 
to unzoom it.  The  button will erase the region of interest. 

Selecting ‘Graph horizontal slice’ will instruct ImageViewApp to spawn GraphViewApp when the 
left mouse button is clicked.  Notice that when this action is active the cursor changes to assist in visual 
feedback.  The data in line with the cursor will be transferred to the GraphViewApp tool to be displayed.  
If a ‘region of interest’ is active, only the data within the box will be displayed in GraphViewApp.  The 
data transferred to GraphViewApp is the native file data, so if smoothing or other rendering functions 
have occurred, the data displayed by GraphViewApp will not reflect this.  Selecting ‘Graph vertical slice’ 
will activate a similar effect, only along the vertical axis.  See Figures 4.18 and 4.19 for examples of a 
GraphViewApp tool being spawned from an ImageViewApp tool.  

The ‘Multiplane playback options’ define how sequential frames will be handled in the playback 
mode.  If the input binary file has multiple planes, then the playback buttons  on the toolbar 
are automatically activated.  These buttons include large reverse step, single reverse step, play, single 
forward, and large forward step.  The playback options determine how the end of data is handled during 
playback and how fast to play the frames.  The speed function also determines the speed of a movie (avi) 
file when it is created from a multi-plane binary data file. 

The settings options on the ‘Colors’ tab is shown in Figure 4.16.  These are designed to define the 
palette and how the data values will be scaled and mapped to specific colors. 
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Figure 4.16.  'Colors' Tab Features in the Settings Dialog 
 

The ‘Palette’ area of the ‘Colors’ tab specifically defines the desired color palette.  Currently there are 
21 pseudo-color scales to choose from. 

Image data files are typically computed so that the result is positive linear amplitude.  Most monitors 
and display devices experience improved performance if the data is scaled in a logarithmic scaling.  
Image files and other positive-value-only files may be rendered Logarithmically or Linearly.  Bi-Polar 
data, such as intermediate files (.api), may not be rendered logarithmically, they must always be scaled 
linearly. 

Definition of the type of scaling is only part of the solution.  The rendering method needs to know the 
minimum and maximum value in which to scale the color map to.  If ‘AUTO FLOAT’ is selected, the 
maximum data value in the file will be used as the Saturation value of the Log scale and Maximum value 
of the linear scale.  In this mode the minimum data value will be the Minimum value of the linear scale.  
Pressing the ‘FIX SCALE’ button will fill the controls with the file’s minimum and maximum values and 
allow the user to manually adjust to the desired values.  In the Logarithmic scale function,. The dynamic 
range must always be specified.  The dynamic range value will effectively compress or stretch the data 
value scaling.  

The ‘Canvas’ tab options of the ‘Settings’ dialog are shown in Figure 4.17.  These options tell the 
visualization tool how to stretch or smooth the data.  If the ‘Fit to Window’ check is active the rendered 
data buffer will always be stretched to just fit within the canvas space.  No scrolling bars will be visible 
because the complete image is displayed.  If this check is disabled, then the rendered data buffer will be 
displayed as is, pixel for pixel, to the canvas.  So if the data is larger than the view of the canvas, then it 
will appear zoomed and scroll bars will be active to position the view port of the canvas.  The ‘Canvas 
Zoom’ option will be active so that the image may be manually enlarged or reduced if desired. 
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Figure 4.17.  'Canvas' Tab Features in the Settings Dialog 
 

The ‘Data Magnification’ numeric value determines whether to expand or contract the data axes into 
the rendered data buffer.  A value of 100% indicates that data axes magnification should only occur to 
maintain the aspect ratio, otherwise it will not scale at all.  A value of 400% indicates to smooth the data 
by a factor of 4 in both directions.  The result of this will be a smoother image (improving coarsely 
sampled data), but the rendered data buffer will expand 16 times larger.  A value of 50% will reduce the 
rendered data buffer size by 2 in both dimensions, but the image will appear more coarse. 

Normally ImageViewApp will try to scale the data in equal linear units where applicable.  The user 
may override this by selecting scaling by ‘Pixels’ if desired.  Also the axes maybe mirrored if desired.  If 
the two axes of the data are not the same units, for example meters and degrees, ‘Image Aspect Scaling’ 
will be forced to ‘Pixel’ mode. 

The contents of ImageViewApp may be exported in a variety of ways.  The window as displayed can 
be saved into the clipboard by pressing the Ctrl-C keys while the mouse is in the window.  From this the 
image can be pasted into any application that can receive BMP images, like MS Paint, MS PowerPoint or 
MS Word.  The image being displayed may also be saved into a BMP file directly using the Save option 
in the File menu or the right mouse click menu. 
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Figure 4.18.  GraphViewApp Data Plot Spawned from ImageViewApp Data Presentation 
 
 

 
 

Figure 4.19.  GraphViewApp Data Plot (db scaled) Spawned from ImageViewApp Data Presentation 
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If the file is a multi-plane file and the movie playback controls are active, then a movie (avi) file may 
be created.  The playback rate is determined by the fps value in the ‘General’ tab of the ‘Settings’ dialog.  
To save into a movie file select the Save option in the File menu or on the right mouse click menu.  
Specify the avi file type and location of the resulting file.  Also the program will prompt for a Video 
Compression selection.  Figure 4.20 shows the current suggested option to select. 
 
 

 
 

Figure 4.20.  Video Compression Dialog for AVI File Creation 
 

4.4 Documentation and the RESULTS Frame 

After data reduction and analysis, it is important to have a plan to accumulate and document the 
results. 

On creation of a new Project in AhisWin Studio the frame ‘RESULTS’ is created automatically.  The 
RESULTS frame’s type is ‘Repository folder’ and has no process flow associated with it in the right pane 
of AhisWin Studio.  It is intended to be a plain folder recognized by AhisWin Studio to accumulate files 
the user selects as important for documentation.  It is recommended to use this Frame to build the Project 
story and document the results of the test associated with this project.  Previous users have found MS 
PowerPoint as a powerful tool for assembling the results into one compact story line.  Photos (jpg files), 
images (BMP files), and movie (avi files) can be easily pasted into one PowerPoint file, annotated, and 
saved into the RESULTS frame.  This file then can be updated as new data is generated. 

The user may choose to create multiple sub-frames to RESULTS if segmenting the results is 
important to clarify the documentation.  To create a sub-folder right click on the RESULTS frame icon in 
the TreeView of AhisWin Studio; select ‘New Sub-Frame…’ on the pop-up menu. 

It is prudent to emphasize the importance of collecting documentation input while the Frames are 
being created and not wait or postpone this to sometime later.  It is highly recommended that photos be 
taken during the scan operation.  Also the Frame User Notes and the Project User Notes should be utilized 
liberally.  There is no limit to the amount of text that can be entered into the User Notes controls and these 
comments become vital for reference purposes during the documentation process.  Scan time is a good 
time to update the Frame specific documentation because there is time to think and formulate thoughts at 
this point in the test cycle.  
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There are a couple of little known Windows shortcuts that are worth highlighting.  It is very handy at 
times to copy a selected window to the system clipboard.  To do this (1) click on the frame of the window 
to select it, (2) press the ‘Alt’ and ‘Print Screen’ keys simultaneously.  An image of the window is now in 
the clipboard for pasting into many common applications (e.g. Paint, PowerPoint, Word, etc).  
Alternatively, an image of the full screen may be captured into the clipboard by pressing the ‘Print 
Screen’ key alone. 

 



 

A.1 

Appendix A 
 

Common AhisWin Studio Operations 

A.1 Create a New Project in AhisWin Studio 
1. Run the AhisWin Studio 4.1 main application.  An option dialog box may appear to open a previous 

Project.  Select the ‘No’ option to this query.  An empty AhisWin Studio 4.1 should now be running. 

2. Select ‘New Project…’ in the ‘File’ pull-down menu (or press  on the taskbar).  A dialog box as 
shown in Figure A.1 will be displayed.  

 

 
 

Figure A.1.  New Project Dialog Box 
 

3. Name the new Project a unique identifying name.  Any valid Windows XP folder character may be 
used in the Project name except the ‘.’ character. 

4. Select  to specify the location where the Project folder will be created. 

5. Specify the Custodian or select that this information will be inherited from the imported Template.  
This may be changed later. 

6. Finally, specify a template to import.  With this feature all or part of a previously collected Project 
may be selected.  Selecting  will show a library of standard Projects that have been 
supplied with the AhisWin Studio software. 
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7. Select the desired Frames to import from the Template Project.  Typically, the Calibration Frame will 
always be selected and at least one of the Target Frames. 

8. Press the ‘OK’ button and the new Project will be created automatically. 

A.2 Create a New Frame in AhisWin Studio 
1. Open the AhisWin Studio 4.1 main application. 

2. As shown in Figure A.2 right click on the Project’s icon within the TreeView pane. 

3. Select ‘New Frame…’ in the popup menu.  A dialog box as shown in Figure A.3 will be displayed.  
 
 

 
 

Figure A.2.  Project Icon Right-Click Popup Menu  
 
 

4. Figure A.3 shows the New Frame dialog box that will be displayed. 

5. Specify a unique Frame name.  This will also become the sub-folder name.  Any valid Windows XP 
folder character may be used in the Frame name except the ‘.’ character. 

6. Usually the Import Template feature should be enabled.  An exception to this may be for a 
‘Repository folder’ frame type. 

7. Specify a template to import.  With this feature all or part of a previously collected Frame may be 
retrieved.  Selecting  will show a library of standard Projects with Frames that may be 
individually imported.  These have been supplied with the AhisWin Studio software. 
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Figure A.3.  New Frame Dialog Box 
 

8. If a Frame that will receive object data is being created, then typically, Pre-Scan Calibration files will 
be imported into this new Frame.  Select the ‘Import Calibration Files’ check to enable this.  The 
source for these calibration files may be selected as the same as the Template Frame by clicking 
‘Same as Template Import’.  Alternatively, select a separate Frame to retrieve the Calibration files 

may be specified by selecting the  browse button. 

9. Press the ‘OK’ button and the new Frame will be created automatically. 

A.3 Using Macros and Batch Processing 

In addition to powerful interactive processing capability AhisWin Studio can ‘remember’ sequences 
of command operations in order that the operator does not have to wait for completion of each command 
in a given sequence.  Many of the computational command operations may take a considerable amount of 
time to execute, especially for large data sets.  The ‘Macro’ file generation and execution support within 
AhisWin Studio provides a powerful tool to integrate any command sequence within a Frame structure 
into a Macro file. 

The architecture of AhisWin Studio is designed for maximum flexibility and portability.  There are 
over 32 independent utility programs recognized by AhisWin Studio that perform the data collection and 
various computation operations on the binary data files.  Each utility is a standalone command-line 
console executable that requires specific arguments on the command line to operate correctly.  The 
Process Manager within AhisWin Studio supplies an interface that assists the user in properly executing 
these utility programs.  In order to execute a batch operation (unattended sequence of commands) one can 
see that a text file could be created that contains a series of these command lines.  In fact this is what a 
AhisWin Studio ‘macro’ file is.  When ‘Teach Macro’ mode is enabled, the Process Manager appends the 
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command line in the specified macro file instead of executing the command.  The Process Manager is 
creating a text file that is compatible with the Windows ‘batch’ file specification. 

To enable ‘Teaching’ a macro, select the check control on the Process Manager pane shown in 
Figure A.4.  Specify a Macro file name.  ‘MAKE.bat’ is the name that is used if ‘Auto name’ is selected 
from the text control’s right mouse click menu.  Once the filename is specified and it is created and 
appears in the TreeView pane under the active frame file list.  If this file previously existed subsequent 
operations will be appended to the exiting commands in the file.  The macro file is a text file and may be 
opened with a text editor by right mouse clicking either the TreeView file or the text control and selecting 
‘Open into a text editor…’.  From this the contents may be reviewed or even cleared in order to reset a 
macro build process. 
 
 

 
 

Figure A.4.  Macro Controls in AhisWin Studio 
 

After the ‘Teach Macro’ mode is enabled, every utility operation that is executed will be appended to 
the macro being taught.  All user prompting occurs during the generation of the macro, so that when the 
macro runs, it may execute unattended.  An exception to this is data acquisition.  The Scan operation (data 
acquisition) is actually performed by a console application.  As such it can be placed as a command line 
in a macro file.  So capturing new data can be invoked in ‘Teach Macro’ mode.  The result of this will be 
a new line in the macro file and no motion will occur.  When the macro is executed the user is prompted 
before motion of the scanner is allowed for safety reasons.  So this one command line is not ‘unattended’, 
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rather it requires user interaction to start it.  For this reason it is recommended that if new data capture is 
desired in a macro file, that it always be placed as the first operation in a macro file.  This has worked 
quite well in the past where a scan is initiated as the first operation of the macro, followed by data 
reduction and other utilities.  The teach mode is disabled and the macro is executed.  The user is prompted 
at first to allow the scan operation to begin motion and when all the lines in the macro are done executing 
sequentially, the final result is available for analysis. 

The teach mode should be disabled before executing a macro.  Unpredictable results may occur if the 
macro file is changed while it is being executed. 

The macro file is a valid Windows batch file and may be directly executed by the system.  To execute 
a macro file with AhisWin Studio right mouse clicking either the TreeView macro file icon or the text 
control and select ‘Run in CMD window…’.  The macro file will be executed sequentially line-by-line as 
a separate process in a separate window. 

A.4 Project Clean-up and Archive 

It is desirable to reduce the disk usage footprint before archiving data sets, whether they are 
individual Frames or full Projects.  Intermediate files are files that were generated in order to create 
images or angular spectrum files.  Intermediate files have the extension ‘ahi’ and ‘ahd’.  Both the ‘ahi’ 
and ‘ahd’ files can be recomputed at a later date if reprocessing is necessary. 

An option has been provided in the Project and Frame mouse right click popup menus that will delete 
all occurrences of these files from folders below the selected icon’s folder.  Select ‘Clean this Project 
(delete intermediate files)…’ on the Project popup menu or to clean a specific Frame select ‘Clean this 
Frame (delete intermediate files)...’ on the Frame’s popup menu. 

This action will permanently delete these large intermediate binary files automatically.  

A.5 AhisWin Studio Known Bugs 

(Space provided for users to add their own notes.) 
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